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1 Scope 
This document is an introduction and explanation of the CSW 5100 Software. 
With the assistance of this document the user will be able to use this software to configure a 
DVCS 5100 system. 
For a description of the Digital Voice Communication System 5100 refer to the following 
DVCS 5100 manuals : 

ACU 5100 DV 64410.04 „Maintenance and Repair“  Article-No. 0545.661-071 
REU 5100 DV 64430.04 „Maintenance and Repair“  Article-No. 0545.686-071 

 
The contents of this document is property of 

 
Becker Flugfunkwerk GmbH 

Baden Airpark B108 
D-77836 Rheinmuenster 

 
and may not be copied or duplicated or published without written consent. 

 
Copyright 2004 by Becker Flugfunkwerk GmbH, all rights are reserved. 
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2 Requirements 

2.1 System 
The minimum installation for proper operation should be: 
• Windows 98/Me/NT/2000/XP 
• CD-ROM Drive 
• PCAN-USB adapter installed 
• USB-Dongle installed 
 

2.2 Connection Cable 
To connect the configuration system to a DVCS 5100 system, you need a special cable set. 
This set adapts the D-SUB9 (male) connector of the configuration system (Pin 2 = BB hi; Pin 
7 = BB lo) with the bus system in your helicopter installation or test bench. You can prepare a 
connection anywhere in the bus system inside the DVCS 5100 helicopter installation. 
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3 Installation 

3.1 Installation Medium 
Becker delivers the CSW 5100 software on a CD-ROM with an setup procedure included for 
an easy installation on your Windows® operating system.  
 

3.2 Program Installation 
The installation process for the CSW 5100 software is started by inserting the CD-ROM into 
your CD-ROM drive. If the auto start for your CD-ROM drive is deactivated in your operating 
system please tart Setup.exe from the installation CD-ROM. This will run the setup 
procedure with all necessary information for the user. 
After the installation process, you will find a shortcut in your Windows® startup menu and on 
the Desktop. 
 
The application is secured by an USB-Dongle which is part of the delivered configuration set.  
Before you are able to use this dongle you have to install the driver which you can find on the 
CD-ROM. Please execute the following installation routine: 

X:\WIBU Key\WkDU-DE.exe 
(Please use the drive identifier of your CD-ROM drive instead of the X!) 
After installation of this driver, Windows® can activate it in the moment you connect the 
dongle to your Computer. 
 
To connect the Computer with the DVCS 5100 a CAN-USB-Adapter is necessary, which is 
attached to the configuration set. If you connect this adapter the first time to your computer, 
Windows® asks you for the driver. You can find it on the CD-ROM. Please tell Windows® the 
following search path if you are ask for: 

X:\CAN-USB\ 
(Please use the drive identifier of your CD-ROM drive instead of the X!) 
 
IF both, the CAN-USB-Adapter and the USB-Dongle are successfully activated on your 
computer, you can start the configuration software CSW5100. 
 
Please note, that the configuration software will in the user mode after first installation on the 
computer. To have access to the system integrator settings you need the accessory 
password (see chapter 9). 
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4 Starting software 

4.1 Main Screen 
Start the Configuration Software via your shortcut on the desktop or in the "START“ menu. 
The following main screen will appear: 
 

 
Figure 1  Start Screen 

The main window is divided in: 

4.2 Menu Bar 
This is the standard WINDOWS menu bar and is the upper bar in the main window. 

4.3 Function Buttons Bar 
Is located at left side and has buttons with direct access to most used functions. 

4.4 Data Window 
Is the biggest window in the middle. The window shows the configuration data after loading 
form the connected DVCS system or from a data file. 

4.5 Status Bar 
The status bar is located at border of the program window and shows some interesting 
messages while program running. 
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5 Menus & Submenus 

5.1 File Menu 
In this menu there are 4 entries for data file handling 1 entry for printing and "Exit“ for 
aborting the configuration software. 
 

 
Figure 2  File Menu 

 

5.1.1 Menu Item “New Data Set” 
You are able to create a new configuration data set by selecting "New Data Set“ from this 
menu. This will load standard configuration data which you can edit in the different data 
screens (explained later). 
 

5.1.2 Menu Item “Open Data File” 
If you have a previously stored data set in a data file and want to open it you will start with 
"Open Data File“. 
 

 
Figure 3  Open Dialog 
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This is a standard windows dialog, so it can have a different appearance. It’s depending to 
the installed windows version and the used language of the operating system. 

5.1.3 Menu Item “Save Data to File” 
For archiving or reproduction you can save a configuration data set to a file. See more details 
at chapter 10 
 

5.1.4 Menu Item “Save as …” 
If you want to save the current configuration data set under a new name select "Save as“: 
 

 
Figure 4  Save Configuration 

This is a standard windows dialog, so it can have a different appearance. It’s depending to 
the installed windows version and the used language of the operating system. 
 

5.1.5 Menu Item “Printer Setup” 
For printer selection and configuration you can use the “Printer Setup” menu entry. 
 

5.1.6 Menu Item “Print Configuration Data” 
If you want to print the current configuration data for documentation you can do this by 
selecting this menu item. The printout will be sent to the standard printer you defined in your 
Windows® operating system if there is an printer available. 
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5.1.7 Menu Item “Exit” 
By selecting this menu item, you can end the work with the configuration software. If you 
made changes in the data set shown on screen, a confirmation window will be shown asking 
the user for saving of this data: 
 

 
Figure 5  Question dialog for program abortion. 

The appearance of this window can be configured in the settings dialog described in chapter 
5.2.1. 

5.2 Options Menu 
In this menu you can select the settings dialog, functions to connect and disconnect the 
system and functions to handle the data exchange with a connected REU5100 : 
 

 
Figure 6  Options Menu 

5.2.1 Menu Item “Settings” 
The selection of the menu item settings starts an dialog for changing some basic settings for 
the program appearance. 

 
Figure 7  Settings Dialog 
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There are three subsets of settings. First you can select the unit for the displayed 
potentiometer values (percentage of max. value or absolute value). Second ,you can define 
the appearance of save data dialogs after “Load from REU” and at program exit. Third, the 
user level (customer or system integrator). 
If you select “Cancel”, no settings will be changed. Selection of “OK” change the settings in 
that way you have selected and they will take affect immediately. 
The settings are stored permanently in the used computer system, so after a restart of the 
CSW 5100 software you will get the same settings you have selected before. 
See chapter 9 to learn more about the user levels. 
 

5.2.2 Menu Item “Connect to REU” 
If you want to make a data exchange between the configuration software and a REU5100 
first you have to create a connection. That can be done by using this menu item or the 
according function button. If the connection is created, this menu item will be disabled. 
 

5.2.3 Menu Item “Disconnect from REU” 
To end a data exchange between the configuration software and a REU5100 it is possible to 
close the connection. That can be done by using this menu item or the according function 
button. If the connection is closed, this menu item will be disabled. 

5.2.4 Menu Item “Load configuration from REU” 
This menu item is enabled while a connection between the configuration software and a 
REU5100 is established. It starts the transfer of all configuration data from the connected 
REU5100 to the host CSW 5100 software. While data transfer a small dialog shows the 
progress of the data exchange. 
 

5.2.5 Menu Item “Send configuration to REU” 
This menu item is enabled while a connection between the configuration software and a 
REU5100 is established. It starts the transfer of all configuration data from the host CSW 
5100 software to the connected REU5100. While data transfer a small dialog shows the 
progress of the data exchange. 
 
 

5.3 Help Menu 
A help system is not jet implemented in this software, so this submenu consists by one entry 
only for displaying the info dialog : 
 

 
Figure 8  Help Menu 

 

5.3.1 Menu Item “Info” 
The selection of this menu item opens a dialog box with info about the program version, the 
author and the contact address.  
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Figure 9  Info Dialog 
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6 Function Buttons 
At the left side of the program screen you can find some buttons for a direct access to most 
used functions.  

 
Figure 10  Function Buttons  

 

6.1 Function Button “Connect”/”Disconnect” 
This button has the same function as the menu item “Connect” or “Disconnect”. The function 
switched in accordance to the connect state of the program. If there is no connection to the 
REU5100 established yet the button can be used to create the connection. Otherwise the 
button can be used to disconnect. 
 

6.2 Function Button “Load from REU” 
This button has the same function as the menu item “Load configuration from REU” (see 
5.2.4). 
 

6.3 Function Button “Print” 
This button has the same function as the menu item “Print Configuration Data” (see 5.1.5). 
 

6.4 Function Button “Exit” 
This button has the same function as the menu item “Exit” (see 5.1.7). 
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7 State Display 
There are two state displays in the left bottom corner of the program screen. One for the 
actually bus state and another for the data state.  
 

 
Figure 11  State Displays  

 

7.1 “Bus State” Display 
This display is been visible when a connection is established only. For an easy visibility is a 
colored block. The color of the block shows the actually bus state. If the connection is o.k. 
the color is green, if there is a failure the color will be changed to red. A yellow colored block 
shows that the host system tries to connect a REU 5100 but actually gets no answer. 
 

7.2 “Data State” Display 
There is one colored block that displays the actually state of the shown data. If the data 
shown on screen are the same as stored in the connected REU5100 the color is green, if 
there was made any change by editing any value the color is yellow until the user send the 
new data to the REU5100. 
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8 Data Screen 
For easy usage the data screen is separated in 7 sheets. You can select each sheet by 
clicking on the tab sheet identifier at top of the data screen.  
 

 
Figure 12  Tab Sheets for Data Screen 

 

8.1 Data Screen “General Settings” 
The first tab sheet shows the general settings of the DVCS system. 
 
 � � � � � 
 

 
Figure 13  Data Screen “General Settings” 

� In this block there are displayed administrative data for storage of a configuration data set 
in a file. This are the date and time of saving, the file name and the individual description 
text. If you do not use file stored data, this fields are blank. The date and time are not 
editable, they are set in the moment you are store the actually data set in a file and will be 
taken from the computer system real time clock.  
See more details at chapter 5.1.4 or chapter 10. 
 
� Here you can see and change the addresses of the REU and the ACUs and the number 
of ACUs that are activated. In Maximum there are 6 ACUs available. The addresses of the 
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ACUs have to be different (2 or more ACUs with the same address are not allowed!). The 
addresses can be a value between 0 and 15. 
 
� Each TX and RX channel in the DVCS can be set available or not. In this box you can do 
this by clicking on the according device name. The showed device names are the same that  
are defined in tab sheet “TX devices” (see 8.3) and RX devices (see 8.4). 
 
� This value represent the attenuation of the sidetone signal in the system. Values between 
–15dB and 0dB in steps of 3dB are available. 
 
� Here you can select whether a CALL tone will appear in the DVCS 5100 system or not. 
 

8.2 Data Screen “ACU Settings” 
This screen shows all configuration data for the ACUs. The screen itself is separated in two 
sheets. One for the basic settings and another for the active volumes. Each ACU can have 
its own configuration. With buttons on the left side you can select the ACU you want to 
configure. If the number of available ACUs is smaller than 6 the buttons for the higher ACUs 
are disabled. 
 

8.2.1 “ACU Settings” Basic Settings 
This sheet shows all the basic settings for an ACU.  
 
� � � � � � � � 
 

 
Figure 14  Data Screen “ACU settings” 
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� This are the buttons for the selection of the ACU you want to configure or see. 
 
� In this box the type of the ACU is be set.  
 
� All function keys on the panel of the ACU can be enabled or disabled. This can be set in 
this box. In addition 4 keys can be configured as active after initialization of the ACU. 
The SPKR key can be set enabled for ACU 1 to 3 only.  
 
� This small box handles the settings for the double TX function. Basically you can enable 
or disable this function. If it is enabled there are two select boxes enabled. With it you are 
able to select the two TX channels for double TX function. It is not possible to select the 
same channel in both boxes. Please take care that the selected channel in the left box has a 
smaller number as in the right box. There are no check whether the selected channels are 
available and enabled! 
 
� Other settings consists by one setting value. With it you can enable the “Forced 
Monitoring” function that result in automatic monitoring the channel you are transmitting. 
 
� In this box all settings for the microphone input can be done. First you can switch between 
standard and dynamic type of microphone. Furthermore you can change the sensitivity of the 
input in the defined ranges. 
 
� The headphone settings are made in this box. The only selection you can made is to 
switch between a 8O ore 300O line. 
 
� For each ACU the TX and RX channels can be enabled or disabled. This can be set in the 
box “Channel Options”. If any channel isn’t enabled, it can’t be used by the user of this ACU. 
The column “Name” shows the name of the channel you can define in the TX or RX devices 
sheet.  The next column “Init State” defines the state of the channel after initialization of that 
ACU. For each  TX channel it is possible to allow or disable PTT function by using the switch 
boxes in the last column. 
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8.2.2 “ACU Settings” Volumes 
For each ACU the volumes can be set individual. This can be made by using this sheet. 
 

� � � � 
 

 
Figure 15  Data Screen “ACU volumes” 

� This are the buttons for the selection of the ACU you want to configure or see. 
 
� In this area the values for the master volume, the intercom volume and the VOX level can 
be set.  
 
� Here the individual volumes for the TX channels can be set. 
 
� In this area the individual volumes for the RX channels can be set. 
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8.3 Data Screen “TX Devices” 
Since different transmitters / transceivers with individual input and output signal levels are 
able to be connected to the DVCS5100 system for each TX channel special setting have to 
be done. For these settings the “TX Devices” page is responsible. 

� � � � � � 
 

 
Figure 16  Data Sc reen “TX device settings” 

� This column shows the standard name for the TX channels. 
 
� For each TX channel you can define a special name for a better identification on the 
different pages. This names are not stored in the REU5100 or the data files you can create! 
They are handled by the CSW5100 program and are individual for each used computer. 
 
� The 3rd column is responsible for the input level setting. The value can be changed by 
using the sliders or the up/down keys. Higher values means a necessary of lower levels at 
the input for reaching the standard level at the headphone. 
 
� The 4th column is responsible for the output level setting. The value can be changed by 
using the sliders or the up/down keys. Higher values means a higher level for the modulation 
of the transmitter. 
 
� In this column you can select the kind of the sidetone for each TX channel. 
Some transmitters are not able to deliver a naturally sidetone. For this case the DVCS 
system can create an artificial sidetone by itself and the signal is routed from the microphone 
line direct to the headphone line. 
Additionally a duplex mode is available. In this mode both, the naturally and the artificial 
sidetone are used. 
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� In the last column the sidetone level can be defined separately for each TX channel. The 
values are selectable between 0dB and –15dB in steps of 3dB. In case of duplex mode this 
value handles the artificial sidetone. The naturally sidetone then is not under attenuation. 
 

8.4 Data Screen “RX Devices” 
Since different receivers with individual output signal levels are able to be connected to the 
DVCS5100 system for each RX channel special setting have to be done. For these settings 
the “RX Devices” page is responsible. 
 
 � � � � 
 

 
Figure 17  Data Screen “RX device settings” 

� This column shows the standard name for the RX channels. 
 
� For each RX channel you can define a special name for a better identification on the 
different pages. This names are not stored in the REU5100 or the data files you can create! 
They are handled by the CSW5100 program and are individual for each used computer. 
 
� In this column you can activate or deactivate the availability of the VOICE filter for each 
RX channel. 
Navigation receivers are delivering an audio signal with different components. For 
suppressing of the voice component in the audio signal the user of the DVCS5100 system 
can activate an voice filter by pressing the VOICE key on the ACU5100 panel. This filter is 
active for the RX channels with activated filter availability only. 
 
� The 4th column is responsible for the input level setting. The value can be changed by 
using the sliders or the up/down keys. Higher values means a necessary of lower levels at 
the input for reaching the standard level at the headphone. 
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8.5 Data Screen “FIX Channels” 
Up to 6 fixed channels can be used for supplying the intercommunication system with special 
audio signals. The volume of this signals can’t be changed by the user while operation. For 
the setting of the volume for the fixed signals the “FIX Devices” page is responsible. 
 
 � � � 
 

 
Figure 18  Data Screen “FIX channel settings” 

� This column shows the standard name for the FIX channels. 
 
� For each FIX channel you can define a special name for a better identification on the 
different pages. This names are not stored in the REU5100 or the data files you can create! 
They are handled by the CSW5100 program and are individual for each used computer. 
 
� The 3rd column is responsible for the input level setting. The value can be changed by 
using the sliders or the up/down keys. Higher values means a necessary of lower levels at 
the input for reaching the standard level at the headphone. 
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8.6 Data Screen “Speakers” 
The DVCS5100 system has the ability to connect in complete 2 independent speaker 
systems. One of this 2 speaker lines at a time can be controlled by ACU1, ACU2 or ACU3. 
The unity is defined before delivering the REU5100 by BECKER. 
On this page you can set the rated power for the speaker lines. 
 
 � � 
 

 
Figure 19  Data Screen “Speaker settings” 

� This column shows the standard name for the speaker channels. 
 
� This column is responsible for the output level setting. The value can be changed by 
using the sliders or the up/down keys. 
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8.7 Data Screen “Warning Tones” 
The DVCS5100 system has the ability to activate 8 different warning tones via discrete 
inputs. This warning tones can be configured in some parameters on the “Warning Tones” 
page.  
 

� � � � � 
 

 
Figure 20  Data Screen “Warning tones settings” 

� This column shows the identification number for each warning tone. 
 
� If warning tones are triggered the user can cancel the warning signal output by activation 
of “Control in 2” (REU5100; P2; Pin 6; Warning Tone Cancellation) if this is allowed by 
setting in this column.  
 
� Some warnings have to be inactive while transmit operation. In this column you can 
configure this function. 
 
� For the warning tones there are 3 priority levels: high, medium and low. Warnings with a 
higher priority are suppressing the output of warnings with lower priority. The 4th column is 
responsible to configure the priority setting. 
 
� The output level of the warning tones can be set in this section. Higher values means a 
higher signal level routed to the headphones. 
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9 User Levels 
The program is made to work with two different user levels (“Customer” and “System 
Integrator”). 
The selection will be done by the settings dialog described at 5.2.1.  
After the first installation of the CSW5100 software on a computer, the user level is 
“Customer”.  To change into the “System Integrator” user level you have to activate “Change 
User Level” in the dialog box. The user level “System Integrator” is selectable by entering a 
special code in the edit field only. Please contact “Becker Flugfunkwerk GmbH” to clarify the 
possibility for you to get this code. After entering the correct code you are able to select an 
user level different to “Customer”. Click “OK” to make the selection active. The data screens 
will be actualized immediately to show all data for the new user level. 
 

9.1 User Level “Customer” 
The user level “Customer” is made for end users which want to configure the system for their 
own requirements. However it is not possible to change the general system configuration like 
addressing, TX/RX channel availability or filter availability. Some configuration fields in the 
CSW5100 software will be shown in gray color and are not editable. This configurations can 
be done by system integrators only. 
 

9.2 User Level “System Integrator” 
The user level “System Integrator” is made for the people which are implementing 
DVCS5100 systems in helicopters. They have all possibilities to configure the system for the 
helicopter requirements. 
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10 Configuration Data Files 
For preparing configurations or a trace ability of the configurations you made, it is possible to 
create configuration files which are stored in individual folders on your computer. For that the 
commands “Open Data File” (see chapter 5.1.2), “Save Data to File” (see chapter 5.1.3) and 
“Save as …” (see chapter 5.1.4) are available in the “File” menu. The data files can not be 
read by a standard editor because of its special format. The file name extension is “DVS” for 
a reliable identification. All configuration data, the date and time of storage and the content of 
the description field are stored in the file. The optional names for TX, RX and FIX channels 
are not saved in the configuration data files. 
 

10.1 Predefinition of Configuration Data Sets 
With the CSW 5100 software you are able to predefine configurations without connected 
DVCS 5100 system. 
After start of the configuration software select “>File >New Data Set” in the menu line (see 
chapter 5.1.1) and a complete configuration data set will attempt on screen. This data set 
based on a standard configuration and can be edited without a connected device. If the 
configuration fits all your requirements, fill the description field on “General Settings” page 
and select “>File >Save as” in the menu line (see chapter 5.1.4). In the “Save as” dialog you 
are able to select your preferred data folder and to give in an filename. 
For additional configuration data sets, repeat this procedure. 
 

10.2 Use Predefined Configuration Data Sets 
To load predefined configuration data sets in a plugged DVCS 5100 system select “>File 
>Open Data File” in the menu line (see chapter 5.1.2). In the attempting “Open file” dialog 
select the data file you want to use and click the “Open” button. The selected configuration 
data set will appear on screen. Press “Connect” in the button bar (see chapter 6.1) to create 
a data link with the connected DVCS 5100 system. After a few moment the “Bus State” 
display (see chapter 7.1) shows a green bar (blinking with yellow color) for a correct data 
link. Now you are able to send the complete configuration data set to the REU 5100 by using 
“Send configuration to REU” in the “Options” menu (5.2.5). 


